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Warranty and Service Policy
Product Warranty
DATAQ Instruments, Inc. warrants that this hardware will be free from defects in materials and workmanship under
normal use and service for a period of 90 days from the date of shipment. DATAQ Instruments' obligations under this
warranty shall not arise until the defective material is shipped freight prepaid to DATAQ Instruments. The only
responsibility of DATAQ Instruments under this warranty is to repair or replace, at its discretion and on a free of
charge basis, the defective material.
This warranty does not extend to products that have been repaired or altered by persons other than DATAQ Instruments employees, or products that have been subjected to misuse, neglect, improper installation, or accident.
DATAQ Instruments shall have no liability for incidental or consequential damages of any kind arising out of the sale,
installation, or use of its products.

Service Policy
1.

All products returned to DATAQ Instruments for service, regardless of warranty status, must be on a freight-prepaid basis.

2.

DATAQ Instruments will repair or replace any defective product within 5 days of its receipt.

3.

For in-warranty repairs, DATAQ Instruments will return repaired items to the buyer freight prepaid. Out of warranty repairs will be returned with freight prepaid and added to the service invoice.
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1. Introduction
This manual contains information designed to familiarize you with the features and functions of the DI-154RS and
the DI-195B serial port data recording modules.

DI-154RS
The DI-154RS is a portable, four-channel data recording module that communicates through the computer’s RS-232
(or serial) port. It can record data at rates of up to 240 samples per second with 12 bits of measurement accuracy. The
DI-154RS is powered directly from the computer to which it is connected (through the RS-232 cable) and is equipped
with four analog input channels and three digital input channels.

DI-195B
The DI-195B is a two-channel data recording module that communicates through the RS-232 (or serial) port. It can
record data at rates of up to 240 samples per second with 12 bits of measurement accuracy. The DI-195B is powered
by the included wall outlet-type adapter, which can be plugged into any single-phase, 120 volt, 60 Hz AC source. It
features two, signal-conditioned, differential, bipolar analog inputs (screw terminal access, maximum measurement
range is defined by the DI-5B modules). The DI-195B allows you to plug any two DI-5B signal conditioning modules into its backplane. The DI-5B signal conditioning modules then filter, isolate, amplify, and/or convert virtually
any industrial signal that is applied into a high level analog voltage, perfectly suited for recording.

WINDAQ/Lite Waveform Recording Software and WINDAQ Waveform
Browser Playback and Analysis Software
The WINDAQ software shipped with all DATAQ Instruments’ serial port products includes WINDAQ/Lite waveform
recording software and WINDAQ Waveform Browser playback and analysis software.
WINDAQ/Lite waveform recording software can be used to record waveforms directly and continuously to disk while
monitoring a real time display of the waveforms on-screen. It operates and displays waveform signals in real time at
the full sample rate of the instrument being used. WINDAQ/Lite is limited to a 240 Hz maximum throughput rate
when recording to disk.
WINDAQ Waveform Browser playback software (also known as “WWB”) offers an easy way to review and analyze
acquired waveforms. A built-in data file translator allows the user to display multiple waveforms acquired by
WINDAQ/Lite or any of a wide range of data acquisition packages. The software’s disk-streaming design allows data
files of any length to be graphically displayed rapidly, in normal or reverse time directions. Seven standard cursorbased measurements, frequency domain, and statistical analysis functions help simplify waveform analysis and interpretation.
Both WINDAQ/Lite and WINDAQ Waveform Browser are available for download free-of-charge from our web site
(www.dataq.com). Click here to open the Fast Start guide to recording and reviewing waveforms.

Help
Both the WINDAQ/Lite and the WINDAQ Waveform Browser software utilize context-sensitive help. For help with
any particular function, simply highlight the menu item in the WINDAQ software and press the F1 key. This will take
you immediately to the help topic most relevant to that menu item. The help files may also be accessed through the
Help menu in the Software. Help files are updated regularly and may be installed through our web site if desired.
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Conventions Used in the Documentation
Before using WINDAQ software, please read this section to understand some of the terms and notational conventions
used here and in the Help Files.

General Conventions
Commands you choose are given with the menu name preceding the command name. For example, the phrase
“Choose File Open” tells you to choose the Open command from the File menu. This naming convention describes
the sequence you follow in choosing a command - first you select the menu, then you choose the command.

Mouse Conventions
In general, most mouse actions require only the left mouse button. For example, carrying out a menu command or
working in a dialog box requires only the left mouse button. Since the majority of mouse procedures are done with
the left mouse button, we will not specify which mouse button to click, drag, or double-click in the procedure unless
the action uses the RIGHT mouse button. For example, “Double-click the right mouse button anywhere in the bottom
annotation line to move the cursor to the lowest displayed waveform valley.”
•

“Point” means to position the mouse pointer until the tip of the pointer rests on what you want to point to on the
screen. For example, “Point to the View menu.”

•

“Click” means to press and immediately release the mouse button without moving the mouse. For example, “To
display the menu that contains the command you want, click the menu name in the menu bar.”

•

“Double-click” means to click the mouse button twice in rapid succession. For example, “Double-click the icon
to start the program.”

•

“Drag” means to press the mouse button and hold it down while you move the mouse; then release the button.
For example, “Drag down to Data Cursor to enabled the cursor for on-screen display.”

WINDAQ Operating Modes
WINDAQ waveform recording software has three operating modes: Setup, Record, and Standby. Each operating
mode shares many features with the other two, but specific modes may restrict features or disable some functions
altogether.
WINDAQ Recording Software starts in the SET UP operating mode. In SET UP mode you can configure data acquisition parameters—such as the number of acquired channels, channel gain, and channel offset—and customize the
real time display. SET UP operating mode provides access to most data acquisition functions and adjustments including control of the real time display screen's scaling and offset functions. The SET UP mode displays data in real time
but does not store data to disk. This mode limits sample rate only by the capabilities of the hardware. In other words,
you can sample as fast as your instrument will allow. When in this mode, the Status: area of the bottom annotation
line displays SET-UP.
The RECORD operating mode stores, or streams, data to disk. Activate the RECORD mode by selecting Record
from the File menu. You can use all waveform recording features and functions (with some restrictions) while in the
RECORD mode except the following: Channel-specific operations (i.e., channel number, gain, offset) and sample
rate adjustments. Waveform information continuously streams to disk while the real time display remains active.
RECORD mode limits sample rate to 240 Hz maximum throughput when using WINDAQ/Lite but does not limit the
sample rate when using WINDAQ/Pro or Pro+ (limit determined by hardware). When in RECORD mode, the Status:
area of the bottom annotation line displays RECORD.
Use the STANDBY operating mode to temporarily suspend (pause) waveform recording to disk. Select Stop in the
File menu to enter STANDBY mode. You can use all waveform recording features and functions except channel-specific operations (i.e., channel number, offset, etc.) and sample rate adjustments. The STANDBY mode displays data
in real time while waveform recording to disk has been stopped. When in this mode, the Status: area of the bottom
annotation line displays STBY. Start and stop as many times as desired during a data acquisition session.
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2. Getting Started
The following items are included with each instrument purchase. Verify that you have the following:
•

DI-154RS or DI-195B instrument.

•

Communications cable designed to connect the instrument to your computer’s serial port (the DI-195B AC
power adapter is integrated into the serial cable).

•

The WINDAQ Resource CD-ROM, which includes this documentation which covers the hardware aspects of the
DI-154RS, and DI-195B serial port modules and also documents WINDAQ/Lite waveform recording software
and WINDAQ Waveform Browser playback and analysis software.

•

If you purchased a DI-195B, you should also have one or two DI-5B plug-in modules. Note that these are extracost items not included with the purchase of the DI-195B kit, but are required for operation.

If an item is missing or damaged, call DATAQ Instruments at 330-668-1444. We will guide you through the appropriate steps for replacing missing or damaged items. Save the original packing material in the unlikely event that your
unit must, for any reason, be sent back to DATAQ Instruments.

Installing the Hardware
NOTE: Before installing WINDAQ software, you should already have the hardware connected to the PC’s serial port.
Use the following procedure to connect the DI-154RS, or DI-195B module to your computer.
DI-154RS and DI-195B Serial Port Connection:
1.

Connect the male end of the communications cable to the 9-pin female connector on the DI-154RS or DI-195B
module.

2.

Connect the other end of the communications cable to your computer’s serial or COM port.

3.

If you purchased the DI-195B, plug the AC power adapter into any standard 120V, 60Hz wall outlet.

Installing WINDAQ Software
1.

Insert the WINDAQ Resource CD into your CD-ROM drive and close the drive tray. For most users, the Windows’ auto-run feature will automatically display a list of options. If you do not see this list of options after a reasonable period of time, double-click the My Computer icon on your desktop and then double-click your CDROM icon to manually display the list of options.

2.

Choose the “Install Software for Starter Kits (DI-154, DI-194, DI-195B)” radio button and click OK.

3.

Choose the “Install WinDaq Starter Kit Software for the DI-154 or DI-195B” radio button and click OK.

4.

The Welcome dialog box allows you to cancel the installation. Click OK to continue.

5.

Read the License agreement and either “Accept and Continue” to continue the installation or “Do not accept and
stop” to cancel the installation.

6.

Select the folder (default is C:\DATAQ) you would like to place the files in and click OK.

7.

Specify the Starter Kit you are installing and click OK.

Getting Started
3

DI-154RS/DI-195B User’s Manual

8.

Specify the COM port you have connected the Starter Kit to and click OK. Installing to a nonexistent COM Port
or to an incorrect COM Port requires the software to be uninstalled and re-installed.

9.

Select the Program Manager Group to save shortcuts to in the Windows Menu (default is WINDAQ) and click
OK.

10. WINDAQ/XL may be installed in the WINDAQ/XL Software dialog box. WINDAQ/XL requires a key from
DATAQ Instruments, Inc. Click Yes to install or No to continue.
11. Advanced CODAS Analysis Software may be installed in the Advanced CODAS Analysis Software dialog box.
Advanced CODAS requires a key from DATAQ Instruments, Inc. Click Yes to install or No to continue.
12. Installation is complete. Click OK to exit the installation program.
Both WINDAQ/Lite and WINDAQ Waveform Browser may be run from the Windows Menu as specified in Step 9
(default is Start > Programs > WINDAQ).

Menu Items Created During Installation
The Sample Files Folder contains 8 different sample files to illustrate the versatility of WINDAQ Software. These
samples are WINDAQ Waveform Browser Files that can be measured, analyzed, and manipulated in any way that you
please.
The WINDAQ XY Viewer icon runs the XY Viewer software. This program allows the user to generate a multi-channel XY plot in real time.
The WINDAQ Lite Data Acq DI-154 (or DI-195B) icon runs the WINDAQ/Lite Data Acquisition Software.
The WINDAQ Waveform Browser icon runs the WINDAQ Waveform Browser Software.
The DATAQ Web page icon links directly to the DATAQ Instruments, Inc. home page.
The How to program DI1xx icon links to the UltimaSerial internet page providing information for programming the
DI-1xx.
The License icon provides the Software Agreement License in text format.
The Meter icon runs the Meter software which may be run while WINDAQ/Lite is running. This program reports
waveform data values in a digital display format.
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3. Connecting Input Signals
To connect signals to the DI-154RS or DI-195B, insert the stripped end of a signal lead into the desired terminal
directly under the screw. Tighten the pressure flap by rotating the screw clockwise with a small screwdriver. Make
sure that the pressure flap tightens only against the signal wire and not the wire insulation. Do not overtighten. Tug
gently on the signal lead to ensure that it is firmly secured.
Loosen
Tighten
Screwdriver

Signal lead
Pressure flap

DI-154RS
All user connections are made to the 8-port screw terminal connector as follows:

CH 1: Channel 1 analog input.
CH 2: Channel 2 signal input.
CH 3: Channel 3 signal input.
CH 4: Channel 4 signal input.

Connecting Input Signals
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Gnd: Signal ground.
Dig 0: Digital input 0.
Dig 1: Digital input 1.
Dig 2: Digital input 2.
Your DI-154RS comes with the on-board waveform generator configured to provide a sample input signal. The onboard waveform generator is enabled by connecting a jumper wire between the CH 1 and Dig 2 inputs.

Input Signal Considerations
The DI-154RS is not an isolated product. This means that it is susceptible to common mode voltages that could cause
damage to the device. Such damage is not covered by the product’s warranty. Please read the following carefully
before using the product and do not hesitate to contact DATAQ Instruments if you have any questions.
The DI-154RS can tolerate a maximum applied voltage of only ±20V peak without damage. Although you may be
certain that the signal you want to measure is lower than this level, a common mode voltage (CMV) with an unknown
value may combine with your signal of interest to exceed this ±20V limit. In such instances, the product will be damaged. Especially in heavy industrial application environments, you should verify that a CMV does not exist before
connecting and using the DI-154RS. We suggest the following procedure:
1.

Prepare the device under test (DUT) as though you were about to make measurements. This includes the connection of any relevant power supplies, computer connections, etc. Do not make ANY signal connections between
your DUT and your data acquisition instrument. Connect the DI-154RS to the serial port of your PC. The field
side where the input signal connection is made should not have anything connected to it at this time.

2.

Test for the presence of a CMV using a digital volt meter (DVM) in the following manner (fig. 1):
a.

Connect one lead of the DVM to the shell of the GND terminal of the DI-154RS' input signal connector.

b.

Connect the other DVM lead to each of several points on your DUT: To the DUT's chassis ground connection; To the DUT's signal common; To the DUT's signal output.

c.

Measure and record the voltage you see in each of the measurements made in 2b using both the DC and AC
settings of your DVM.

d.

Should any reading obtained in 2c exceed 15VDC or 10.6VRMS, DO NOT CONNECT SIGNALS to your
data acquisition instrument. A common mode voltage exists that can potentially destroy the instrument.
You must determine the source of the CMV and eliminate it before making any measurement. Feel free to
contact DATAQ Instruments for guidance.

Figure 1:

DUT

signal
signal
common
chassis

V
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DI-195B
All user connections are made to the two, four-port screw terminal connectors.
This connector not used
(excitation and power is supplied by the
wall outlet power adapter/serial
communications cable).

PWR

GND

DIN

GND

DATAQ INSTRUMENTS INC
DI-195B REV A 1997
+

U1
JP3

CHANNEL 1

R4

JP4

Q2

IN-

R3

C9

EX-

R5

U4

CH2

R2

C1
C2

Q1

D1
D2
D3
D4

Y1

CHANNEL 2

U5

EX+

C10
C4

+

+ D7

D6
R6
R7
D5
R8
R9
R10

P1

U2

IN+

U6

R1

CH1

Channel 2 Inputs
(EX = Excitation)

C3

EX+

C6 + C7 + C8

IN+

+

IN-

U3

Channel 1 Inputs
(EX = Excitation)

JP7

C5

EX-

Connect male-end of serial communications cable here.
Connect other end of serial communications cable to PC's
COM port. Plug adapter into any standard 120V, 60Hz,
single-phase outlet.

IN+ and IN- are the signal input terminals for each channel. EX+ and EX- are excitation voltage outputs for those
transducers that require excitation. Obviously, you'll want to tailor the DI-5B signal conditioning modules used in the
instrument to the kind of input signals you wish to record.

Input Signal Considerations
Model DI-195B requires one or two 5B-style signal conditioning modules for proper operation. These modules provide a variety of input signal configurations, as defined by the specific module used. A common feature of all 5B
modules is built-in input-to-output isolation. This feature allows the DI-195B to tolerate common mode voltages as
high as 1000VDC or peak AC. Further, 5B-style modules will tolerate up to 240vrms normal mode voltage (applied
continuously across the module's input terminals). The common mode and normal mode specs of 5B modules allow
the 195B to tolerate a wide range of measurement abuse and still perform as expected, or at the very least, not fail.
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